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Microsemi makes no warranty, representation, or guarantee regarding the information contained
herein or the suitability of its products and services for any particular purpose, nor does
Microsemi assume any liability whatsoever arising out of the application or use of any product or
circuit. The products sold hereunder and any other products sold by Microsemi have been
subject to limited testing and should not be used in conjunction with mission-critical equipment
or applications. Any performance specifications are believed to be reliable but are not verified,
and Buyer must conduct and complete all performance and other testing of the products, alone
and together with, or installed in, any end-products. Buyer shall not rely on any data and
performance specifications or parameters provided by Microsemi. It is the Buyer’s responsibility
to independently determine suitability of any products and to test and verify the same. The
information provided by Microsemi hereunder is provided “as is, where is” and with all faults,
and the entire risk associated with such information is entirely with the Buyer. Microsemi does
not grant, explicitly or implicitly, to any party any patent rights, licenses, or any other IP rights,
whether with regard to such information itself or anything described by suchinformation.
Information provided in this document is proprietary to Microsemi, and Microsemi reserves the
right to make any changes to the information in this document or to any products and services
at any time without notice.

About Microsemi

Microsemi Corporation (NASDAQ: MSCC) offers a comprehensive portfolio of semiconductor
and system solutions for aerospace & defense, communications, data center and industrial
markets. Products include high-performance and radiation-hardened analog mixed-signal
integrated circuits, FPGAs, SoCs and ASICs; power management products; timing and
synchronization devices and precise time solutions, setting the world's standard for time; voice
processing devices; RF solutions; discrete components; enterprise storage and communication
solutions; security technologies and scalable anti-tamper products; Ethernet solutions; Power-
over-Ethernet ICs and midspans; as well as custom design capabilities and services. Microsemi
is headquartered in Aliso Viejo, California, and has approximately 4,800 employees globally.
Learn more at www.microsemi.com.
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Introduction to FlashPro Express

About

About

FlashPro Express

FlashPro Express is Microsemi’s programming software tool designed from the ground up to address secured
programming assurance in production programming house environments. FlashPro Express software supports
PolarFire ™, PolarFire SoC ™, SmartFusion®2, IGLOO®2, and RTG4™ in the Windows and Linux OS
environments, using the FlashPro Programmer hardware.

You can install FlashPro Express two ways:

e Integrated with Libero - FlashPro Express is installed automatically when Libero is installed. FlashPro
Express is used by Libero to perform the programming tasks for PolarFire, PolarFire SoC, SmartFusion2,
IGLOO2, and RTG4, as part of the design flow.

e Stand-Alone - FlashPro Express is also available as a standalone installation. This mode is primarily used
for production programming or lab programming on machines in which a full version of Libero is not
required.

See the Microsemi website for more information on FlashPro Express.

FlashPro Programmer

The FlashPro series of hardware programmers saves you board space because a single JTAG chain can be used
for all JTAG devices. In-system programming using the JTAG port adds the flexibility of field upgrades or post-
assembly production-line characterization. Production costs are significantly reduced as a result of elimination of
expensive sockets on the board.

See programmer sections and the Microsemi website for details on FlashPro3/X, FlashPro4, FlashPro5 and
FlashPro6.

Note: FlashPro 5 and FlashPro 6 support programming though the device SPI Slave port as well.

Secure Job Programming

Job programming is the concept of using a single file to program a Microsemi device or chain of Microsemi
devices using encrypted bitstreams.

The single job file contains all of the information necessary to setup FlashPro Express as well as the encrypted
bitstream images for the devices in the job. Once a job file is created it can be handed off securely to production
programming houses or contract engineering facilities to load the Microsemi images during manufacturing. Job
projects can be exported from Libero and imported into stand-alone FlashPro Express providing a clean
delineation between design flow and production programming.

Migrating FlashPro Projects to FlashPro Express

Existing FlashPro projects (*.pro) files are now called Job Project files in FlashPro Express. These Job Projects
can be opened with FlashPro Express to take advantage of Linux programming support and the simplified tool
targeted for operators in a production floor environment.

FlashPro projects that were created in single mode will not be supported with this tool. Microsemi recommends
that you convert these projects to chain mode projects. To convert the project to a chain project, do the following
steps:

1. Open the FlashPro project (*.pro) in FlashPro.

2. Locate the loaded STAPL file by one of two methods:

The log will print “STAPL file ‘<stapl_path>" has been loaded successfully.” <stapl_path> is the location of
the STAPL file loaded.



https://www.microsemi.com/products/fpga-soc/design-resources/programming/flashpro#overview
https://www.microsemi.com/product-directory/programming/4977-flashpro#hardware
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X Software Version: 11.5.0.15
A\ |Warning: cug ; i ; L
TA file 'D:\test_project\projectData\topdefault.stp' has been lcaded successfully.
: vop:; CHECHSIM : FE73; ALG VERSION : 2

[ * T an {Erors J| Warnngs ) Info [

Within the Single Device Configuration Window there is a field STAPL_FILE_NAME, which displays
the location of the STAPL file loaded.

=| Programming file

topdefault.stp ?

DATE MODIFIED Wed Oct 29 15:-:Z0:25 2014 -
STAPL._FILE NAME D:\test_projecti\projectData’topdefault_st|
CEEATOR FlashPro Version: wll_4
DEVICE MZS050T =
|z |PRCEAEGE MZS5050T-£g484
'§ DATE Z2014/08/18
=| |STAPL _VERSICN JESD71 -
E| |TDCODE OF20Z1CF
W |IDMASE OFFFFFFF
o |pEsTew top 1l
c| |rERrwere FE72
o 1| 1l | »
T E
o
@
la [ Chain Parameter... Inspect Device
1]
2
|.E
n

3. Switch the project to chain mode by one of the two methods:
a  Press the chain button from the toolbar.

|

b.  From the Tools menu, select Mode->ChainProgramming.
4. Load the STAPL file in chain mode by adding a Microsemi device in the chain.
a From the File menu, select Configuration->Add Microsemi Devices from Files.
b Browse to the location of the STAPL file and click Open.
5. To save the project, from the File menu, select Save Project.
6. You may now open the project using FlashPro Express.
When moving FlashPro project (*.pro) files to another machine, Microsemi recommends that you archive the
entire project folder, copy it to the new machine, extract it locally, then load the job project within FlashPro

Express. FlashPro Express will only open a job project if a programmer is connected to the machine, at least one
Microsemi device has programmed enabled, and all enabled Microsemi devices have a bitstream file loaded.




& Microsemi

a A\ MicrocHIP company

FlashPro Express User Guide

Supported Families - FlashPro Express

The table below lists the device families and their derivatives that FlashPro Express can program directly through
Libero or by exporting a FlashPro Express job:

Table 1 - Product Families and Derivatives Directly Supported by FlashPro Express

Device Family Description

PolarFire Lowest power, cost optimized, mid-range solution

PolarFireSoC Lowest power, multi-core RISC-V SoC FPGA

SmartFusion2 Address fundamental requirements for advanced security, high reliability and low
power in critical industrial, military, aviation, communications and medical applications.

IGLOO2 Low-power mixed-signal programmable solution

RTG4 Radiation-tolerant programmable solution

Installing FlashPro Express Software and Hardware

See the Microsemi Website for more information about FlashPro Express.



https://www.microsemi.com/products/fpga-soc/fpga/polarfire-fpga
https://www.microsemi.com/product-directory/soc-fpgas/5498-polarfire-soc-fpga
https://www.microsemi.com/products/fpga-soc/soc-fpga/smartfusion2
https://www.microsemi.com/products/fpga-soc/fpga/igloo2-fpga
https://www.microsemi.com/products/fpga-soc/radtolerant-fpgas/rtg4
https://www.microsemi.com/products/fpga-soc/design-resources/programming/flashpro#overview
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Getting Started

Starting FlashPro Express

Start FlashPro Express by running the program at [installation folder] > bin > FPExpress.

FlashPro Express Interface

The main FlashPro Express Ul consists of a list of programmers and a chain table, as shown in the figure below.
This view displays the programmers connected to the machine, and the devices within the JTAG chain (Figure 1)
or a single device with SPI Slave interface (Figure 2) specified in the job project file (PRO) file.

e Hover over the programmer Info icon to display more information about aprogrammer.

e Click the Name field to change a programmername.

e Click the checkbox to enable or disable aprogrammer.

¢ Right-click a programmer to Ping, Self-Test, Scan, Check Chain or Remove it from the list.

e Additional information about a device and programming file, if loaded, can be viewed by hovering over the
info icon of that device.

e Devices specified as disabled in the job project (*.pro) file are shown disabled and their HighZ value is
displayed in the column header.

e Device/Programmer States:
o |IDLE: The devices/programmers are idle and not executing any programmingaction.
e DISABLED: Devices that are not enabled for programming
e PASSED: The last programming operation passed
o FAILED: The last programming operation failed
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programmer '
prograemer '
(ST TS B
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Opened ' /i ran/chainddewices /chainddevices. pro’
Project saved. e

Figure 1 - FlashPro Express Programmers and Chain Table (JTAG example)

Note: SPI Slave mode is supported by FlashPro5 for SmartFusion2 and IGLOO2 devices, and by FlashPro6 for
SmartFusion2, IGLOO2, and PolarFire devices. JTAG is the default interface.

@ FlashPro Express E\sd1_spi_slave\sd1_spi_slave.pro - SPI Slave Programming Interface El

Project Edit View Programmer Help

Refresh/Rescan Programmers

Programmer

®  msisots G

@ so T

1| @V [sd002 DLE | DLE

e —
| IDLE

RUN

Log

(E) Messages €3 Errors & Warnings @ Info |

PPD file 'E:\sdl_spi_slave\sdl_spi_slave.ppd' has been loaded successfully. d
DESIGN : sdl; CHECKSUM : 7E87; PDB_VERSION : 1.0

creating folder: E:\sdl_spi_slave\projectData

Software Versiom: 12.500.0.14

PPD file 'E:\sdl_spi_slave\sdl_spi_slave.ppd' has been loaded successfully.

DESIGN : sdl; CHECKSUM : 7E87; PDB_VERSION : 1.0

Driver : 3.0.0 build 1

programmer '84093' : FlashProd

Created FlashPro Express Job Project. -

Z

Figure 2 - FlashPro Express Programmers and Chain Table (SPI Slave example)

Note: RTG4 devices do not support SPI Slave programming.
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Creating a Job Project from a FlashPro Express Job

Once you are ready to hand off your design for production you can create a job project. To do so:

1. InLibero run Export FlashPro Express Job to create a container that will be used to transfer programming
configuration information, including programming files, to the production programming tool FlashPro
Express.

Design settings
Programming options set with the Configure Programming Options tool:
Design version -0 Back Level version - 0
Security options set with the Configure Security tool:
Encrypt bitstream with default key. Mo user keys or security settings are enabled.

FlashPro Express Job file
Configured device chain with bitstream files and programmer settings will be included in the programming job.
MName: |h3p Location: |D: \Designs_Projiv12_2\ex1\designer\topiexport J
Existing files:
This folder is empty.

Program {ITAG programming interface):
¥ Design

I~ spr 1]

Design bitstream file format: |PPD (*.ppd) X o

Design bitstream file type:

| Fabric/shivm |

File to program at trusted fadility v

Zerpization actions:
[ Like Mew (Erases all user data; device can be immediately reprogrammed by user)

[ Unrecoverable (Erases all data and destroys reprogrammability; device must be scrapped)

Help Ok | Cancel |

Figure 3 - Export FlashPro Express Job

2. In FlashPro Express, from the Project menu choose New Job Project From FlashPro Express Job. You
will be prompted to specify the Programming Job File location that you just exported from Libero and the
location of where to store the FlashPro Express Job Project. The Job Project name automatically uses the
programming job name and cannot be changed. Click OK and a new Job Project will be created and opened
for production programming.
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New Job Project from FlashPro Express Job

Programming job file:

.fsumf5qate5t9!50uthardfprnj_vll_afs_dfd esigner/sort_4/export/sort_4.job

FlashPro Express job project name:

ﬁ sort_4

FlashPro Express job project location:

.fsumf5qate5t9!50uthardfprnj_vll_afs_dfrpx

Qo[ &

Figure 4 - New Job Project from FlashPro Express Job Dialog Box

Load a Job Project

To get started in FlashPro Express you must load a job project (*.pro file). To do so, from the Project menu
choose Open Job Project. A job project will open if:

e Atleast 1 programmer is connected
e Atleast 1 Microsemi device is enabled for programming
e Any enabled Microsemi device for programming must have a bitstream fileloaded

To open a project:
1 From the Project menu, choose Open Job Project. The Open Project dialog boxappears.
2 Find your project file or type in your project file name in the File namefield.
3 Click Open.
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24 FlashPro Express =[5 ]
Project Edit View Programmer Help
Job Projects
Lreate,;
Open..,
Recent Projects
Log & X
j_Mmages_ ¥ Erors i, Wamings i} Info

Figure 5 - FlashPro Express Launch Screen

Saving a Job Project

Click the Save button on the toolbar, or from the Project menu choose Save Job Project to save your project.

Programming Tutorials

Parallel Programming with FlashPro5/4/3/3X

Parallel programming enables you to program multiple Microsemi devices in parallel with multiple programmers.
In parallel programming, all targeted devices are programmed with the same programming file (STAPL). The
targeted device or chain configuration that is connected to each programmer must be identical.

The FlashPro Express software together with the FlashPro5/4/3/3X programmers supports parallel programming
via a USB port. You can connect up to sixteen FlashPro5/4/3/3X's to a PC viaa USB v1.1 or a USB v2.0 port.
FlashPro5/4/3/3X requires a self-powered hub.

Connecting FlashPro5/4/3/3X (a USB v2.0 enabled programmer) to USB v1.1 port increases device programming
time due to a slow data transfer rate on the USB v1.1 port in comparison to a USB v2.0 port.

The following figure illustrates how you can connect a FlashPro5/4/3/3X programmer for parallel programming.

11
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>| FlashPro3 ProAsICIE
H FlashPro3 ProASIC3I/E
u

g P————>

> FlashPro3 '—b-ProASI[yE
H
; FlashPro3 ProAsIC3/E

E ————»

TN
l

>

Figure 6 - Connecting a FlashPro5/4/3/3X Programmer

An independent thread processes the STAPL file during parallel programming. In an Microsemi test, parallel
programming is approximately five times faster than programming 16 devices sequentially.

Note: Microsemi has tested Belkin PCI-USB cards and hubs. We have found that parallel programming
works best with the vendor's latest driver installed and with the matching hubs.

Chain Programming Tutorial

This tutorial demonstrates how to use FlashPro Express to program a multi-device, multi-programmer chain. This
tutorial uses the production programming flow that exports a programming job from Libero SoC, which includes
chain configuration, programmer settings, and bitstream files for programming, and creates a job project from a
programming job.

The figure below shows the chain used in this tutorial. M2S050T is device 1 and A3P250 is device 3. Device 1 is
the first device to be programmed in the chain and device 2 is the last; device 3 is disabled and will not be
programmed.

[25 FlashPro Express CAlipnFPexpress_Tutora\FPexpress_projectitest/test.pro

Project  Edit  View Programmer Help

| Refresh/Rescan Programmers |
i ] mzsosor R azrElson AIPZ50
[Programamer
@To0 TS @To0 TS GTDO HghZ OFF TDI O
1 (@ oese IDLE IDLE I0LE DISABLED
: PR smm INE IOLE I0LE DISABLED

Figure 7 - Chain Programming Devices

To program a chain:

1. From the Project menu, choose New Job Project from FlashPro Express Job.

2. Click Browse to load a Programming Job File, and specify your FlashPro Express job project location.
Click OK to continue, as shown in the figure below.

12



& Microsemi

a A\ MicrocHIP company

FlashPro Express User Guide

New Job Project from FlashPro Express Job

Programming job file:

- Isaftfsqates.tQJ.fsr:-u-thardfprnj_ull_ﬂifs_elfd esigner;fsnrt_4fexpnrf!sort_4.jab

FlashPro Express job project name:

o sort_4

FlashPro Express job project location:

-Isoftfsqates.tgifsnu-thardfprnj_ull_&.fs_elfrpx '

(T

Figure 8 - New Job Project from FlashPro Express Job

FlashPro Express displays your Job Project and programmers, as shown in the figure below. The
Device/Programmer states are:

P |

e |IDLE: The devices/programmers are idle and not executing any programming action
e DISABLED: Devices that are not enabled for programming

e PASSED: The last programming operation passed

e FAILED: The last programming operation failed

[ FlashPro Bxpress - Chbirentchandeuice shchainldsce s peo | e |
Project  Edit  View  Progremmer  Help

i il el
I (i ] AP0 (] MZSOET (] MESOED
=100 o S =100 Tou & 5 TDO o
1 BE e e e e mE
: @ IDE e e BE
[ i EIE s e e HLE
4+ BF e e e DU OLE r
5 @ sm e IHE IDUE ME
e @F sz e e IowE DE
i B IE IEE ICRE EME
5 @ s0m MeE INE InE BAE
s BF e e e e mLE
w @EF = IDE e i e I
FROGRAM -
RUN IDLE
Log & x
IoE===y L

peu—r
prograsaes '
pEOGEARERT !
programser '
prograsser '
prograsser !
Prograeses ‘8558
prograsmer 'H40%
prograeacs ‘B
prograsser !
P0G E AR
Opened (0 s wices/chainidevices. pro’

Froject sawed. =

Figure 9 - FlashPro Express with Loaded Job Project (JTAG example)
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[E=H EoE =

E FlashPro Express E\sd1_spi_slave\sd1l_spi_slave.pro - SPI Slave Programming Interface

Project Edit View Programmer Help

Refresh/Rescan Programmers

Programmer

©®  vsisors

@ SO D14

j @F [s4003 DLE IDLE

PROGRAM -

Log & x
(E) Messages €3 Errors i, Warnings ) Info
PED file 'E:\sdl spi slave\sdl =pi slave.ppd' has been loaded successfully. -]

DESIGN : sdl; CHECKSUM : 7E87; PDB_VERSION : 1.0
creating folder: E:\sdl spi_slave\projectData

Software Version: 12.500.0.14

PPD file 'E:\sdl_spi slave\sdl spi slave.ppd' has been loaded successfully.
DESIGN : sdl; CHECESUM : 7EB7; PDE_VERSION : 1.0

Driver : 3.0.0 build 1

programmer '84093' : FlashPro4

Created FlashPro Express Job Project.

Figure 10 - FlashPro Express with Loaded Job Project (SPI Slave example — SmartFusion2/IGLOO2 only)
See the Export Programming Job topic for information on how to generate a Programming Job file.

3. Click the Refresh/Rescan button if your programmer is not listed. Hover your mouse over the Info icon to
view device info. If a device is Disabled for programming the HighZ status appears in the GUI, as shown in
the figure above.

4. Set the Programming Action in the dropdown menu to PROGRAM, as shown in the figure below.

|PROGRAM -]

DEVICE_INFO
EMC_DATA_AUTHEMTICATION

ERASE

|READ_IDCODE |
g VERIFY 18
Figure 11 - Programming Action Set to PROGRAM

5. Click RUN. Detailed individual programmer and device status information appears in the Programmer List.
Your programmer status (PASSED or FAILED) appears in the Programmer Status Bar, as shown in the

figure below.
e Hover over the Programmer Status Bar to display information on the programmers.

e Hover over the FAILED status to list all programmers that failed programming.
o Hover over the PASSED status to list all the programmers that programmed successfully.

14
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@ .i"l.as.HP'ru\Emress C\llj\FPupres:_Tutun ahF Pécpress Jm.)jel-:t"\.u‘sate:tpm
Edit  View Programmer Help

Praject
AwEISN0 @) A3P250

M25050T
GTDO  TDIG BP0 TDIG  ITDO Highz OFF TDIG
D O e INESIN WSS WSS oses
PR [ L omem |

2

T reroseamnes) passeo | ERGERMERGIEIED)
|
8 x

| RUN
Log
([ETvessoges) @ Erars i warmns @ 1nfo
vvvvv AT S T 08 i’aw:E;?is 2014 (Elapsed time 00:00:00) 2
3

proogames
Chain Programming Finished: Mon Jun 09

0O-0-0-0-0=-0

Figure 12 - Chain Programming Complete
View the Log for Messages, Errors, Warnings and Info generated during programming
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Programmer Settings and Operations

Introduction

The FlashPro Express software enables you to connect multiple programmers to your computer. With each
programmer you select, you can connect the programmer, perform a self-test, customize, add, and remove and
analyze the JTAG chain, as shown in the figure below.

B2 FlashPro Express Z:\QTFP_testing\pc_pro_FP\m2s050_896fbga_fab\m2s050_896fbga_fab.pro

Project Edt View Prognmmer Help
RafrashRescan Programmers
i [i] MZS0s0T
ammer
- = TDO Ol 3
1 | @E e IDLE H-f miE
. 2 — 3 Pig
Self Test
Scan and check chan
Remove
Enable/Disable
PROGRAM -
Log B x
() Messages | €3 Ermors 1, Wamings i Info
STAPL file 'I:\QTFF_teating\pc_pro_FP\u2s050_896fbga_fab\projectData‘sdl.stp' has been loaded successfully. ~
DESIGN : =dl; CHECKSUM : 9EDF: ALG_VERSION : 2
Driver : 3.0.0 build 1
programmer '87272' : FlashProd
Opened 'I:/QTFP_testing/pc_pro_FP/m2s050_8%6fbga_fab/u2s050_896fbga_fab.pro' w

Figure 13 - FlashPro Express Right-Click Menu

Programmer Settings

In the Libero SoC Design Flow window, expand Configure Hardware, double-click Configure Programmer, or
right-click Configure Programmer and choose Programmer Settings to view the Programmer Settings dialog.

For the JTAG interface, you can set specific voltage and force TCK frequency values for your programmer in this
dialog. For the SPI Slave interface, you can set specific voltage and force SCK frequency values for your
programmer. SPI Slave mode is supported by FlashPro5 for SmartFusion2 and IGLOO?2 devices, and by
FlashPro6 for SmartFusion2, IGLOO2, and PolarFire devices. SPI Slave mode is not supported for RTG4
devices. JTAG is the default interface.
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[E7 Programmer Settings X

FlashPro&/Embedded FlashPro6 ] FlashPro5 |  FlashPro4 FlashPro3 |
JTAG interface

TCK Mode: Discrete Clocking

[~ Force TCK Frequency
4 MHz

o Embedded FlashPro& on iCicle Kit supports TCK at 4MHz and above,
TCKis forced at 4MHz when lower frequency is selected.

SPI Slave interface {FlashPro6 only)

SCK Mode: Free Running Clodk

| Force SCK Freguency

SetDefaults

| ’—I
1 Help OK Cancel

Figure 14 - Programmer Settings

The Programmer Settings dialog includes setting options for FlashPro6/5/4/3/3X.
Limitation of the TCK frequency for the selected programmer:
e FlashPro6:1,2,3,4,5,6,7,8,9, 10,11, 12, 13, 14, 15, 16, 17, 18, 19, 20 MHz
e FlashPro5:1, 2, 3, 4,5, 6,10, 15, 30 MHz
e FlashPro4:1, 2, 3,4,5,6 MHz
e FlashPro3/3X: 1, 2, 3,4, 6 MHz
TCK frequency limits by target device:
o Refer to target device data sheet

During execution, the frequency set by the FREQUENCY statement in the PDB/STAPL file overrides the TCK
frequency setting selected by you in the Programmer Settings dialog box unless you also select the Force TCK
Frequency checkbox.

Limitation of the SCK frequency for the selected programmer: 1.00, 2.00, 2.50, 3.33, 4.00, 5.00, 6.67, 8.00, 10.00,
13.33, 20.00 MHz
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FlashPro5/4/3/3X Programmer Settings

For FlashPro5/4/3/3X, if you choose the Force TCK Frequency, select the appropriate MHz frequency. For
FlashPro4/3X settings, you can switch the TCK mode between Free running clock and Discrete clocking. Discrete
clocking should be used when there is a JTAG non-compliant device in a chain with Microsemi devices. After you
have made your selections(s), click OK.

Default Settings

e The Force TCK Frequency option is unchecked to instruct the FlashPro5/4/3/3X to use the TCK frequency
specified by the Frequency statement in the PDB/STAPL file(s).

e FlashPro5/4/3/3X default TCK mode setting is Free runningclock.
TCK Setting (Force TCK Frequency)

If Force TCK Frequency is checked (in the Programmer Setting), the selected TCK value is set for the
programmer and the Frequency statement in the PDB/STAPL file is ignored.

Default TCK frequency

When the IPD/STAPL file or Chain does not exist, the default TCK frequency is set to 4AMHz. When more than
one Microsemi flash device is targeted in the chain, the FlashPro Express software passes through all of the files
and searches for the "freq" keyword and the "MAX_FREQ" Note field. The FlashPro Express software uses the
lesser value of all the TCK frequency settings and the "MAX_FREQ" Note field values.

Ping Programmers

Right-click a programmer and choose Ping.
Note: You can click the Refresh/Rescan for Programmers button to quickly ping new programmers.

Performing a Self-Test

Right-click the programmer you want to self-test and choose Self Test.

Note: You must connect the programmer to the self-test board that comes with your programmer before
performing a self-test.

Note: Self-test is not supported with FlashPro5/4 programmers. These programmers are rigorously tested
at the factory during production.

Scanning and Checking a Chain

The scan chain operation scans and analyzes the JTAG chain connected to programmer(s) you have selected
and checks that chain scanned matches the chain configured in FlashPro Express.

To scan a chain:
Right-click the programmer you want to scan and choose Scan and check chain.

Enabling and Disabling Programmers

After loading a job project, you can enable/disable or remove a programmer and can also ping, self-test, run scan
and check chain on any of the connected programmers. These actions are available in the shortcut menu (right-
click) for each of the programmers listed in the programmer column.

Click the checkbox next to a programmer in the Programmer column to enable or disable it. The programmer is
enabled when there is a tick mark in the checkbox and disabled when the checkbox is empty.

Renaming a Programmer

Enter the new programmer name in the Programmer window to rename the programmer. By default, the
programmer name is the same as the programmer ID.
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Removing a Programmer

Right-click the programmer and choose Remove.

Selecting and Running an Action

FlashPro Express supports the following programming actions:
e DEVICE_INFO
e ENC_DATA_AUTHENTICATION

This action is only visible if every device in the chain contains encrypted bitstream files. Selecting this action
causes each bitstream file to be checked for authentication.

e ERASE

¢ PROGRAM

e READ_IDCODE
e VERIFY

To select a programming action:

Select an action from the Programming Action dropdown menu in FlashPro Express, as shown in the figure
below.

|PROGRAM -]
| DEVICE_INFO
ENC_DATA_AUTHEMTICATIGN
|ERASE

|READ_IDCODE :
vg VERIFY |

Figure 15 - FlashPro Express Programming Actions

To run the selected programming action:
Click on the RUN button below the Programming Action drop-down menu.
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Chain Programming

Chain Order

Chain Programming enables you to program several devices at one time. The order of devices in the chain

imported from Job Project must match the physical chain to be programmed.

The TDO for the first device connects to the programmer, and the last device's TDI connects to the programmer.
The devices in the chain go in order from a device's TDI into the next device's TDO, as shown in the figure below.

125 FlashPra Exprass  Cikian'chainddecesichainddesices.pro

Project  Edit  View  Programmer  Help

Refreshjfiescan Pragrammers

07 anm
: @F s
3 OF  ene
4+ @E s
s @F san
: @F sun
7 @ e
s @F owes
5 @ s

w @F  eas

[PRoGR
~ RUN

Lo

Frogrammer

8 E B E (BB B E

[[ElFias | @ Erars 4, Wamings @ Irfo

PP

prograamer '87L4D0' :
t FlashProd

prograamer '83958'

prograamer '956BL' :
prograaner '84074' :
t FlashProd

prograamer ‘84021

progroaner '96585'

prograaner '34083'
prograamer ‘871,
prograaner ‘952

programmer '86746' :
Opened 'C:/kiran/chainidevices/chainidevices.pro’

Project saved.

FlashPro4
FlashProd

FlashPro4

FlashProd
FlashPro4
FlashProd

: FlashPro4

FlashProd

AFPTSI

HLE

WLE

ILE

LE

HLE

HLE

HLE

LE

HLE

ILE

0 [ ] MES060T

ILE

WLE

ILE
HLE
LE
HLE
HLE
HLE

ILE

[ ] MESaS0T

IDLE
WLE
HLE

ICLE

ILE
ELE
ILE
ELE

ILE

IDLE

=y =]

Multiple Device Chain Programming

Figure 16 - Chain Order

The FlashPro Express software enables direct chain programming without generating a chain STAPL file. Each
device will be programmed in sequential order starting from device 1 to device N. See example below. For more
information about chain order, see the Chain Order help topic.

TDI > Device N > Device N-1 >... > Device 2 > Device 1 > TDO

Device Programming Compatibility
PolarFire, SmartFusion2, IGLOO2, and RTG4 devices can be programmed in the same chain.
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Programmer Support

FlashPro5/4/3/3X supports PolarFire, SmartFusion2, IGLOO2, and RTG4 devices. The Vpump on
FlashPro5/4/3/3X is designed to support the programming of only one device. Make sure that Vpump, Vcc, and
Vjtag are provided on board for chain programming. Connect the Vpump to the header as the Flashpro Express
software will attempt to check for all external supplies, including Vpump, to ensure successful programming.
There is no limitation to the chain length; however, ensure that the JTAG signal integrity and the timing are
preserved.
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FlashPro Express Modes

Starting with Libero SoC v12.5, FlashPro Express supports two modes: operator mode and developer
mode. Operator mode is a current flow that provides production programming. It is the default mode.

Developer mode allows to update jobs before running programming. It allows to enable/disable chain
devices; load design and SPI Flash Programming files and select different programming actions for each
chain devices and SPI-Flash. Like operator mode, developer mode also allows you to run selected actions
for all devices. Developer mode also allows you to run actions selected for each device.

The Operator or Developer mode can be selected through the Preference dialog (Project >
Preferences). The preference is saved per user per machine on Windows and per user on
Linux. The mode preference remains the same until the user changes it.

@ Preferences U X

Software update

| FlashPro Express mode:
 FlashPro Express Mode

© Production programming (operator mode)

“  Allow job updates before programming (developer 1

al | 12
Help OK | Cancel ‘

Figure 17 - FlashPro Express Mode Preference Dialog (Windows)

Preferences

Software update
PDF reader

Default web browser: |fusribin/firefox
FlashPro Express Mode

To change the default web browser, enter the new web brows

Additional command-line options: |

4 | 2

Help Cancel ‘ oK |

Figure 18 - FlashPro Express Mode Preference Dialog (Linux)
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The FlashPro Express mode can be switched before opening a job. And, if there is a job
opened, the user will be prompted to confirm closing of the job to save the mode preference,
when the user clicks the “OK” button.

After a job is opened in developer mode, each device displays:

a) Aninfo (0) icon with device specific data.

b) Designicon (33} ). the per-device selected action is displayed next to the icon, if “Run selected action for all
devices” option is unselected

c) SPI Flash icon (i ) if SPI Flash programming is available for the device. the per-device selected SPI Flash
action is displayed next to the icon, if the “Run selected action for all devices” option is unselected

d) Configure button (ﬂ) providing a menu of configuration options based on the device. The configure button is
enabled when no programming action is running.

Developer mode features:

1. Device configure options

E FlashPro Express F\joy jobs\g5_design_spi__g4_design\g5_design_spi__g4 design.pro - JTAG Programming Interface - O
Project Edit View Programmer Help

Refresh/Rescan Programmers

© MPF30O(T|TS|TLITLS) %] | @ M25/M2GLOSO(TITS)  [g& ‘
Programmer & PROGRAM & PROGRAM v Enable Device for Programming...
E

<100 ™I & < TDO To! Load Programming File...

Select and Configure Action/Procedures to program design...

j © ¥ |138015F IDLE IDLE IDLE

[ Run selected action for all devices

Figure 19 - Device Options to Program Design

@ FlashPro Express F\joy_jobs\g5_design_spi__g4 design\g5_design_spi__g4_design.pro - JTAG Programming Interface
Project Edit View Programmer Help

Refresh/Rescan Programmers

© MPF300(T|TS|TLITLS)  [4& ‘ O M2S/M2GLOSO(T|TS) g% ‘
Programmer & PROGRAM v Enable Device for Programming...
E S

p— . Load Programming File...

Select and Configure Action/Procedures to program design...
j © [ [138015F IDLE IDLE Load SPI Flash File..

Select SPI Flash Action...

[ Run selected action for all devices

Figure 20 - Device Options to Program Design and SPI Flash
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Enable/Disable device for programming

The option allows the device to be enabled or disabled (put in “bypass”).

The user must load the programming file when enabling a device that is currently in “bypass”, with no
programming file associated with the device or SPI-Flash. As a result, the device header info tooltip is updated
with selected programming action, if enabled, or “bypass”, if disabled.

Notes:

e The job cannot be saved if there is all devices are disabled or if any of enabled devices does not have
loaded programming file.

e |f all the devices are disabled an actions combo box and a “run” button are disabled.

Load Programming File

The option is available for the enabled devices to load a different programming file for the target device.
FlashPro Express requires all programming files to be in the local job folder. When loading a programming file
from outside the job folder the file will be copied to the job folder first and then loaded for the selected device.
The user must confirm copying the programming file to the job folder and overwriting the existing file.

Select a programming action and configure actions and procedures per device

The option allows the selection of the programming action and configuration of the actions’ procedures. The
option is available for an enabled device that has programming file loaded, and when the “Run selected action
for all devices” option is unselected.

Load SPI Flash file

This option allows the user to load a different SPI Flash programming file.

Select SPI Flash Action

The option allows the selection of the programming action for the SPI Flash. The option is available for the
enabled device that has SPI Flash Programming File loaded, and when the “Run selected action for all devices”
option is unselected.
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2. Program device selected

In developer mode, when the “Run selected action for all devices” checkbox is selected, FlashPro Express runs
selected action from the dropdown list below the checkbox for all enabled devices — similar to the Operator mode.

actions
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Project Edit View Programmer Help

Refresh/Rescan Programmers

@ FlashPro Express F:\joy_jobs\g5_design_spi__g4_design\g5_design_spi__g4 design.pro - JTAG Programming Interface

j O [ [138015F IDLE

M Run selected action for all devices

|PROGRAM/PROGRAM_SPT_IMAGE  ~|

RUN

© MPF300(T|TS|TLITLS)  @%| | @ M25/M2GLOSO(TITS) @]
Programmer # PROGRAM #F PROGRAM
¥ PROGRAM_SPI_IMAGE
<3 TDO TDI <2 <3 TDO TDI <2
IDLE IDLE

IDLE

Figure 21 - Run One Action for All Chain Devices

When the Run selected action for all devices” checkbox is unselected, the actions dropdown list is disabled. And,
FlashPro Express runs the programming actions for the enabled device and SPI Flash, as selected uniquely for each

device.

@ FlashPro Express F\joy_jobs\g5_design_spi__g4_design\g5_design_spi__g4_design.pro - JTAG Programming Interface

Project Edit View Programmer Help

Refresh/Rescan Programmers

RUN

© MPF300(T|TS|TL|TLS) ﬂ © M25/M2GLO50(T|TS) ﬂ
Programmer i PROGRAM & PROGRAM
< TDO TDI <2 <3 TDO TDI <2
J © ¥ |138015F IDLE IDLE IDLE
[ Run selected action for all devices
|

Figure 22 - Run Device Selected Actions
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TCL Commands - FlashPro Express

About TCL Commands - FlashPro Express Tcl Command
Reference

Note: For details about all Tcl commands supported by FlashPro Express, see the Tcl Command
Reference Guide (SmartFusion2, IGLOO2, RTG4) and Tcl Command Reference Guide (PolarFire).

A Tcl (Tool Command Language) file contains scripts for simple or complex tasks. You can run scripts from the
Windows command line or store and run a series of Tcl commands in a *.tcl batch file.

Note: Tcl commands are case sensitive. However, their arguments are not.

Running Tcl Scripts from within FlashPro Express

Instead of running scripts from the command line, you can use FlashPro Express's Execute Script dialog box to
run a script.

To execute a Tcl script file within FlashPro Express:
1 From the File menu, choose Execute Script to display the Run Script dialog box.

[ [ Run Script ER=)

SaiptFie: | csss)

Arguments:

Cancel

(R |

Figure 23 - Run Script Dialog Box

2. Click the Browse button to display the Open dialog box, in which you can navigate to the folder containing
the script file to open. When you click Open, FlashPro Express enters the full path and script flename into
the Run Script dialog box for you.

3. Inthe Arguments box, enter the arguments to pass to your Tcl script. Separate each argument by a space
character. For information about accessing arguments passed to a Tcl script, see Running Tcl Scripts From
the Command Line.

4. Click Run.
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Running Tcl Scripts from the Command Line

You can run Tcl scripts from your Windows or Linux command line.

To execute a Tcl script file in the FlashPro Express software from a shell command line:

1

2.

At the prompt, type the path to the Microsemi software followed by the word "SCRIPT" and a colon, and then
the name of the script file asfollows:

<location of Microsemi software>/bin/FPExpress.exe SCRIPT:<filename>

The example below executes in batch mode the script foo.tcl:

<location of Microsemi software>/bin/FPExpress.exe script:foo.tcl

The example below executes in batch mode the script foo.tcl and exports the log in the file foo.txt:
<location of Microsemi software>/bin/FPExpress.exe script:foo.tcl logfile:foo.txt
The example below executes in batch mode the script foo.tcl, creates a console where the log is
displayed briefly, and exports the log in the file foo.txt:

<location of Microsemi software>/bin/FPExpress.exe script:foo.tcl console_mode:brief
logfile:foo.txt

If you leave console_mode unspecified or set it to 'hide’ FlashPro Express executes without a console
window. If you want to leave the console window open you can run the script with the console_mode
parameter set to 'show’, as in the following example:

<location of Microsemi software>/bin/FPExpress.exe script:foo.tclconsole_mode:show
logfile:foo.txt

If you want to pass arguments to the Tcl script from the command line, then use the "SCRIPT_ARGS"
variable as follows:

<location of Microsemi software>/bin/FPExpress.exe SCRIPT:<filename>SCRIPT_ARGS: "paraml
param2 param3™

Arguments passed to a Tcl script can be accessed through the Tcl variables argc and argv. The example
below demonstrates how a Tcl script accesses these arguments:

puts "Script name: $argv0"
puts "Number of arguments: $argc"
set i O
foreach arg $argv {
puts "Arg $i : $arg"
incr i
}
Note: Script names can contain spaces if the script name is protected with double quotes:
FPExpress script:"FPExpress tcl/foo 1.tcl"

Exporting Tcl Scripts from within FlashPro Express

To export a set of Tcl commands from the FlashPro Express history:

1
2.

From the File menu, choose Export Script File.
Enter the filename and click Save. The Export Script Options dialog appears (as shown in the figure below).
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Figure 24 - Script Export Options Dialog Box

3. Check the Include commands from current project only to export commands of the current project
only. You can specify the filename formatting by selecting Relative filenames (relative to the current
directory) or Qualified filenames (absolute path, including the directory name).

4. Click OK.

28



FlashPro Express User Guide

& Microsemi

a A\ MicrocHIP company

Troubleshooting

Exit Codes (PolarFire)

Error Exit Message Exit Possible Cause Possible Solution
Code Code
Passed (no error) 0 - -
0x8002 Failed to disable 5 Unstable voltage level Monitor related power supplies that cause the
programming mode issue during programming; check for transients
Signal integrity issues on outside of Microsemi specifications. See your
Failed to set JTAG pins device datasheet for more information on
programming mode transient specifications.
Monitor JTAG supply pins during programming;
measure JTAG signals for noise or reflection.
0x8032 Device is busy 5 Unstable VDDIx voltage Monitor related power supplies that cause the
level issue during programming; check for transients
outside of Microsemi specifications. See your
device datasheet for more information on
transient specifications.
0x8003 Failed to enter 5 Unstable voltage level Monitor related power supplies that cause the
programming mode issue during programming; check for transients
Signal integrity issues on outside of Microsemi specifications. See your
JTAG pins device datasheet for more information on
transient specifications.
DEVRST_N is tied to LOW
Monitor JTAG supply pins during programming;
measure JTAG signals for noise or reflection.
Tie DEVRST_N to HIGH prior to programming
the device.
0x8004 Failed to verify 6 Incorrect programming file Choose the correct programming file and select
IDCODE the correct device in the chain.
Incorrect device in chain
Measure JTAG pins and noise for reflection. If
Signal integrity issues on TRST is left floating then add pull-up to pin.
JTAG pins
Reduce the length of Ground connection.
0x8005 Failed to verify FPGA | 11 Device is programmed with | Verify the device is programmed with the
0x8006 Array a different design or the correct data/design.
0x8007 component is blank.
0x8008 Failed to verify Fabric Monitor related power supplies that cause the
Configuration Unstable voltage level. issue during programming; check for transients
outside of Microsemi specifications. See your
Failed to verify Signal integrity issues on device datasheet for more information on
Security JTAG pins. transient specifications.
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Error Exit Message Exit Possible Cause Possible Solution
Code Code
Monitor JTAG supply pins during programming;
Failed to verify SNVM measure JTAG signals for noise or reflection.
0x8013 External digest check | -18 External Digest check via Need to use a hitstream file which has a valid
via JTAG/SPI Slave is JTAG/SPI Slave is disabled. | FlashLock/UPK1 to enable external digest
disabled. check via JTAG/SPI Slave.
0x8015 FPGA Fabric digest -20 FPGA Fabiric is either If the Fabric is erased, deselect procedure
verification: FAIL erased or the data has been | "DO_ENABLE_FABRIC" from action
corrupted or tampered with | "VERIFY_DIGEST"
Deselect procedure
'DO_ENABLE_FABRI
C' to remove this
digest check.
0x8016 sNVM digest -20 sNVM is either erased or the | If the sNVM is erased, deselect procedure
verification: FAIL data has been corrupted or | "DO_ENABLE_SNVM" from action
tampered with "VERIFY_DIGEST"
Deselect procedure
'DO_ENABLE_SNVM'
to remove this digest
check.
0x8018 User security -20 Security segment is either If the security is erased, deselect procedure
policies segment erased or the data has been | "DO_ENABLE_SECURITY" from action
digest verification: corrupted or tampered with | "VERIFY_DIGEST"
FAIL
Deselect procedure
'DO_ENABLE_SECU
RITY' to remove this
digest check.
0x8019 UPK1 segment digest | -20 UPK1 segment is either If the UPK1 is erased, deselect procedure
verification: FAIL erased or the data has been | "DO_ENABLE_SECURITY" from action
corrupted or tampered with | "VERIFY_DIGEST"
Deselect procedure
'DO_ENABLE_SECU
RITY' to remove this
digest check.
0x801A UPK2 segment digest | -20 UPK2 segment is either If the UPK2 is erased, deselect procedure
verification: FAIL erased or the data has been | "DO_ENABLE_UKS2" from action
corrupted or tampered with | "VERIFY_DIGEST"
Deselect procedure
'DO_ENABLE_UKS2'
to remove this digest
check.
0x801B Factory row and -20 Factory row and factory key
factory key segment segment have been erased
digest verification: through zeroization or the
FAIL data has been corrupted or
tampered with
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Error Exit Message Exit Possible Cause Possible Solution
Code Code
0x801C Fabric configuration -20 Fabric configuration If the Fabric configuration is erased, deselect
segment digest segment is either erased or | procedure "DO_ENABLE_FABRIC" from action
verification: FAIL has been corrupted or "VERIFY_DIGEST"
tampered with
Deselect procedure
'DO_ENABLE_FABRI
C' to remove this
digest check.
0x8052 UEK1 segment digest | -20 UEK1 segment is either If the UEK1 is erased, deselect procedure
verification: FAIL erased or the data has been | "DO_ENABLE_UEK1" from action
corrupted or tampered with | "VERIFY_DIGEST"
Deselect procedure
'DO_ENABLE_UEKY'
to remove this digest
check.
0x8053 UEK?2 segment digest | -20 UEK2 segment is either If the UEK2 is erased, deselect procedure
verification: FAIL erased or the data has been | "DO_ENABLE_UEK2" from action
corrupted or tampered with | "VERIFY_DIGEST"
Deselect procedure
'DO_ENABLE_UEK?2'
to remove this digest
check.
0x8054 DPK segment digest | -20 DPK segment is either If the DPK is erased, deselect procedure
verification: FAIL erased or the data has been | "DO_ENABLE_DPK" from action
corrupted or tampered with | "VERIFY_DIGEST"
Deselect procedure
'DO_ENABLE_DPK'
to remove this digest
check.
0x8057 SMK segment digest | -20 SMK segment is either If the SMK is erased, deselect procedure
verification: FAIL erased or the data has been | "DO_ENABLE_SMK" from action
corrupted or tampered with | "VERIFY_DIGEST"
0x8058 User Public Key -20 User Public Key segment is | If the User Public Key is erased, deselect
segment digest either erased or the data procedure
verification: FAIL has been corrupted or "DO_ENABLE_USER_PUBLIC_KEY" from
tampered with action "VERIFY_DIGEST"
0x801D Device security -21 The device is protected with | Run DEVICE_INFO to view security features
prevented operation user pass key 1 and the that are protected.
bitstream file does not
contain user pass key 1. Provide a bitstream file with a user pass key 1
that matches the user pass key 1 programmed
User pass key 1 in the into the device.
bitstream file does not
match the device.
0x801F Programming Error. -22 Bitstream file has been Regenerate bitstream file
corrupted or was incorrectly
generated. Monitor related power supplies that cause the

31




FlashPro Express User Guide

& Microsemi

a KX sompany
a MicrocHIP company

Error Exit Message Exit Possible Cause Possible Solution
Code Code
Bitstream or data is issue during programming; check for transients
corrupted or noisy Unstable voltage level. outside of Microsemi specifications. See your
device datasheet for more information on
Signal integrity issues on transient specifications.
JTAG pins. Monitor JTAG supply pins during programming;
measure JTAG signals for noise or reflection.
0x8021 Programming Error. -23 File contains an encrypted Provide a programming file with an encryption
key that does not match the | key that matches that on the device
Invalid/Corrupted device
encryption key First program security with master programming
File contains user file, then program with user encryption 1/2 field
encryption key, but device update programming files
has not been programmed
with the user encryption key
0x8023 Programming Error. -24 Design version is not higher | Generate a programming file with a design
than the back-level version higher than the back level version
Back level not programmed device
satisfied
0x8001 Failure to read DSN -24 Device is in System TRSTB should be driven High or disable
Controller Suspend Mode "System Controller Suspend Mode".
Check board connections
0x8027 Programming Error. -26 Device does not support the | Generate a programming file with the correct
capabilities specified in capabilities for the target device
Insufficient device programming file
capabilities
0x8029 Programming Error. -27 Incorrect programming file Choose the correct programming file and select
the correct device in chain
Incorrect DEVICEID Incorrect device in chain
Measure JTAG pins and noise or reflection. If
Signal integrity issues on TRST is left floating, then add pull-up to pin
JTAG pins
Reduce the length of ground connection
0x802B Programming Error. -28 Programming file version is | Generate programming file with latest version of
out of date Libero SoC
Programming file is
out of date, please
regenerate.
0x8030 Programming Error -31 FAB_RESET_N is tied to FAB_RESET_N should be tied to HIGH
ground
Invalid or inaccessible
Device Certificate
0x8032 Instruction timed out | -32 Unstable voltage level Monitor related power supplies that cause the
0x8034 issue during programming; check for transients
0x8036 Signal integrity issues on outside of Microsemi specifications. See your
0x8038 JTAG pins device datasheet for more information on
transient specifications.

32




FlashPro Express User Guide

& Microsemi

a A\ MicrocHIP company

Error Exit Message Exit Possible Cause Possible Solution
Code Code
Monitor JTAG supply pins during programming;
measure JTAG signals for noise or reflection.
0x8010 Failed to unlock user | -35 Pass key in file does not Provide a programming file with a pass key that
pass key 1 match device matches pass key programmed into the device.
0x8011 Failed to unlock user | -35 Pass key in file does not Provide a programming file with a pass key that
pass key 2 match device matches pass key programmed into the device.
0x804F Bitstream -38 Unstable voltage level Monitor related power supplies that cause the
programming action is issue during programming; check for transients
disabled Bitstream programming outside of Microsemi specifications. See your
action has been disabled in | device datasheet for more information on
Security Policy Manager transient specifications.
Need to use a bitstream file which has a
valid FlashLock/UPK1 to enable the
bitstream programming action.
0x805B Error, security must -42 Security only bitstream Use this bitstream on a blank device or
be either programmed programming on a generate a new bitstream that contains the
on a blank device or programmed device FPGA Fabric design along with the security
with the FPGA Fabric
design

Exit Codes (RTGA4)

Error Code Exit Message Possible Cause Possible Solution
Passed (no error) - -
0x8001 Failure to read DSN Device is in System TRSTB should be driven High on device power
Controller Suspend Mode | up.
Check board connections | Disable System Controller Suspend Mode in
"Programming Bitstream Settings' tool within
Libero and reprogram the device.
0x8002 Device is busy Unstable VDDIx voltage Monitor related power supplies that cause the
level issue during programming; check for transients
outside of Microsemi specifications. See your
device datasheet for more information on
transient specifications.
0x8003 Failed to enter Unstable voltage level Monitor related power supplies that cause the
programming mode issue during programming; check for transients
Signal integrity issues on
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Error Code Exit Message Possible Cause Possible Solution
JTAG pins outside of Microsemi specifications. See your
device datasheet for more information on
DEVRST_N is tied to LOW | transient specifications.
Monitor JTAG supply pins during
programming; measure JTAG signals for noise
or reflection.
Tie DEVRST_N to HIGH prior to programming
the device
0x8004 Failed to verify IDCODE | Incorrect programming file | Choose the correct programming file and select
the correct device in the chain.
Incorrect device in chain
Measure JTAG pins and noise for reflection. If
Signal integrity TRST is left floating then add pull-up to pin.
issues on JTAG pins
Reduce the length of Ground connection.
0x8005 Failed to verify IDCODE | Programming file is for Generate a programming file for RT4G150
RT4G150_ES RT4G150_ES and device
STAP'—T”E Is not device is RT4G150 Choose the correct programming file and select
CRC_’l_rzgaltge W':jh _ Incorrect the correct device in the chain.
) production programming file Measure JTAG pins and noise for reflection. If
devices. You must use . . .
a STAPL file for Incorrect device in TRST is left floating then add pull-up to pin.
RT4G150 chain Reduce the length of Ground connection.
device. Signal integrity
issues on JTAG pins
0x8006 Failed to verify IDCODE | Programming file is Generate a programming file for
RT4G150 for RT4G150 and RT4G150_ES device
STAPL file is not device is Choose the correct programming file and select
CR?I'T(?EEI(? Vl‘é'tsh RT4G150_ES the correct device in the chain.
i — Incorrect Measure JTAG pins and noise for reflection. If
devices. You must use a L . . .
STAPL file for programming file TRST is left floating then add pull-up to pin.
RT4G150 ES Incorrect device in Reduce the length of Ground connection.
device. chain
Signal integrity
issues on JTAG pins
0x8007 Failed to verify FPGA Device is programmed Verify the device is programmed with the
Array with a different design or correct data/design.
the component is blank. Monitor related power supplies that cause the
Unstable voltage level. issue during programming; check for transients
Signal integrity outsjde of Microsemi specifications. See your
issues on JTAG pins. device

34




FlashPro Express User Guide

& Microsemi

a A\ MicrocHIP company

Error Code Exit Message Possible Cause Possible Solution
datasheet for more information on transient
specifications.
Monitor JTAG supply pins during
programming; measure JTAG signals for noise
or reflection.
0x8008 Device is blank Attempting to verify digest | Program the device prior to running action
of a blank device "VERIFY_DIGEST"
0x8009 FPGA array digest Digest check has been Drive TRSTB high during device power up.
check is disabled dissbledby Enable digest check in "Programming Bitstream
Programming Bitstream | gettings" tool within Libero and reprogram the
Settings" tool within device.
Libero
0x800A Failed to verify digest: Unstable voltage level Try running VERIFY_DIGEST action again.
Instruction timed out Signal integrity Monitor related power supplies that cause the
issues on JTAG pins issue during programming; check for transients
outside of Microsemi specifications. See your
device datasheet for more information on
transient specifications.
Monitor JTAG supply pins during
programming; measure JTAG signals for noise
or reflection.
0x800B FPGA Fabric digest Programming Use the same programming file that was
verification: FAIL bitstream components used to program the device.
do not match
components
programmed
FPGA Fabric is either
erased or the data has
been corrupted or
tampered with
0x800C Factory row segment Programming Use the same programming file that was
digest verification: FAIL | bitstream components used to program the device.
do not match
components
programmed
Factory row segment data
has been corrupted or
tampered with
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Error Code Exit Message Possible Cause Possible Solution
0x800D Bitstream Error. Bitstream file has Regenerate bitstream file
Bitstream or data is been corrupted Monitor related power supplies that cause the
corrupted or noisy. Bitstream was issue during programming; check for transients
incorrectly generated outside of Microsemi specifications. See your
Unstable voltage level device datasheet for more information on
. . . transient specifications.
Signal integrity
issues on JTAG pins
Monitor JTAG supply pins during
programming; measure JTAG signals for noise
or reflection.
0x800E Failed to query Unstable voltage level Try running DEVICE_INFO action again.
programming bitstream | signal integrity Monitor related power supplies that cause the
settings: Instruction issues on JTAG pins issue during programming; check for transients
timed out outside of Microsemi specifications. See your
device datasheet for more information on
transient specifications.
Monitor JTAG supply pins during
programming; measure JTAG signals for noise
or reflection.
0x800F Bitstream Error. Incorrect | Incorrect programming file | Choose the correct programming file and select
DEVICEID Incorrect device in chain the correct device in the chain.
Signal integrity Measu_re JTAG pins and noise for reflecti_on. If
issues on JTAG pins TRST is left floating then add pull-up to pin.
Reduce the length of Ground connection.
0x8010 Operation has been Operation has been Drive TRSTB high during device power up
disabled by disabled by Enable the disabled operation in the
programming bitstream | "Programming Bitstream | "programming Bitstream Settings" tool with
settings Settings” tool within Libero and reprogram the device
Libero
User disabled Fabric
Erase/Write/Verify
and attempted to
Erase/Program/Verify
the device
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Error Code

Exit Message

Possible Cause

Possible Solution

0x8011

Failed to check
bitstream: Instruction
timed out

Unstable voltage level

Signal integrity
issues on JTAG pins

Monitor related power supplies that cause the
issue during programming; check for transients
outside of Microsemi specifications. See your
device datasheet for more information on
transient specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals for noise
or reflection.

0x8012, 0x8013

Failed to erase device:
Instruction timed out

Unstable voltage level
Signal integrity issues on
JTAG pins

Monitor related power supplies that cause the
issue during programming; check for transients
outside of Microsemi specifications. See your
device datasheet for more information on
transient specifications.

Monitor JTAG supply pins during programming;
measure JTAG signals for noise or reflection.

0x8014

Failed to program
device: Instruction
timed out

Unstable voltage level

Signal integrity
issues on JTAG pins

Monitor related power supplies that cause the
issue during programming; check for transients
outside of Microsemi specifications. See your
device datasheet for more information on
transient specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals for noise
or reflection.

0x8015

Error, device is not
ready.

DEVRST_N may have
been driven LOW during
programming

Need to ensure that DEVRST_N is driven HIGH
during programming. The reliability of the device
in space cannot be guaranteed if this has
occurred. It is the user's responsibility to ensure
that DEVRST_N is driven HIGH during
programming.
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Error
Code

Exit
Code

Exit Message

Possible Cause

Possible Solution

0

Passed (no error)

0x8002

5

Failure to configure
device programming at
1.2/1.0 VCC voltage

Unstable voltage level

Signal integrity issues on
JTAG pins

Monitor related power supplies that cause
the issue during programming; check for
transients outside of Microsemi
specifications. See your device datasheet
for more information on transient
specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.

0x8032

Device is busy

Unstable VDDIx voltage level

Monitor related power supplies that cause
the issue during programming; check for
transients outside of Microsemi
specifications. See your device datasheet
for more information on transient
specifications.

0x8003

Failed to enter
programming mode

Unstable voltage level

Signal integrity issues on
JTAG pins

DEVRST_N is tied to LOW

Monitor related power supplies that cause
the issue during programming; check for
transients outside of Microsemi
specifications. See your device datasheet
for more information on transient
specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.

Tie DEVRST_N to HIGH prior to
programming the device.

0x8004

Failed to verify IDCODE

Incorrect programming file
Incorrect device in chain

Signal integrity issues on
JTAG pins

Choose the correct programming file and
select the correct device in the chain.

Measure JTAG pins and noise for
reflection. If TRST is left floating then add
pull-up to pin.

Reduce the length of Ground connection.

0x8005
0x8006
8x804A

10

Failed to program eNVM

Unstable voltage level.

Signal integrity issues on
JTAG pins.

Monitor related power supplies that cause
the issue during programming; check for
transients outside of Microsemi
specifications. See your device datasheet
for more information on transient
specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.
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Error Exit Exit Message Possible Cause Possible Solution
Code Code
0x8027 10 Authentication Error Libero device selection does Generate a programming file with the
0x8028 not match the target device. correct device selection for the target
Bitstream and device device.
mismatch
0x8007 11 Failed to verify FPGA Device is programmed with a | Verify the device is programmed with the
0x804C Array different design or the correct data/design.
component is blank.
Failed to verify Fabric Monitor related power supplies that cause
Configuration Unstable voltage level. the issue during programming; check for
transients outside of Microsemi
Failed to verify Security | Signal integrity issues on specifications. See your device datasheet
JTAG pins. for more information on transient
specifications.
Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.
0x8008 11 Failed to verify eNVM Device is programmed with a | Verify the device is programmed with the
0x8009 different design. correct data/design.
0x8049
Unstable voltage level. Monitor related power supplies that cause
the issue during programming; check for
Signal integrity issues on transients outside of Microsemi
JTAG pins. specifications. See your device datasheet
for more information on transient
specifications.
Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.
0x8013 -18 Digest request from Digest request from SPI/JJTAG | Provide a programming file with a pass
SPI/JTAG is protected by | is protected by user pass key | key that matches pass key programmed
User Pass Key 1 1. Lock bit has been into the device.
configured in the Debug Policy
within SPM (Security Policy
Manager)
0x8014 -19 Failed to verify digest >Unstable voltage level Monitor related power supplies that cause
the issue during programming; check for
Signal integrity issues on transients outside of Microsemi
JTAG pins specifications. See your device datasheet
for more information on transient
specifications.
Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.
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Error
Code

Exit
Code

Exit Message

Possible Cause

Possible Solution

0x8015

-20

FPGA Fabric digest
verification: FAIL

Programming bitstream
components do not match
components programmed

FPGA Fabric is either erased
or the data has been
corrupted or tampered with

Use the same programming file that was
used to program the device.

0x8016

eNVM_0 digest
verification: FAIL

Programming bitstream
components do not match
components programmed

eNVM_0 data has been
corrupted or tampered with

Use the same programming file that was
used to program the device.

0x8017

eNVM_1 digest
verification: FAIL

Programming bitstream
components do not match
components programmed

eNVM_1 data has been
corrupted or tampered with

Use the same programming file that was
used to program the device.

0x8018

User security policies
segment digest
verification: FAIL

Programming bitstream
components do not match
components programmed

User security policy segment
data has been corrupted or
tampered with

Use the same programming file that was
used to program the device.

0x8019

User key set 1 segment
digest verification: FAIL

Programming bitstream
components do not match
components programmed

User key set 1 segment data
has been corrupted or
tampered with

Use the same programming file that was
used to program the device.

0x801A

User key set 2 segment
digest verification: FAIL

Programming bitstream
components do not match
components programmed

User key set 2 segment data
has been corrupted or
tampered with

Use the same programming file that was
used to program the device.

0x801B

Factory row and factory
key segment digest
verification: FAIL

Programming bitstream
components do not match
components programmed

Factory row and factory key
segment data has been
corrupted or tampered with

Use the same programming file that was
used to program the device.
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Error Exit Exit Message Possible Cause Possible Solution
Code Code
0x801C -20 Fabric configuration Programming bitstream Use the same programming file that was
segment digest components do not match used to program the device.
verification: FAIL components programmed.
Fabric configuration segment
data has been corrupted or
tampered with
0x801D |-21 Device security The device is protected with Run DEVICE_INFO to view security
0x801E prevented operation user pass key 1 and the features that are protected.
0x804B bitstream file does not contain
user pass key 1. Provide a bitstream file with a user pass
key 1 that matches the user pass key 1
User pass key 1 in the programmed into the device.
bitstream file does not match
the device.
0x801F -22 Authentication Error eNVM has been locked by a Release the lock on the eNVM after your
0x8020 master in your design master has completed its access
0x8040 Bitstream or data is operations. Write 0x00 to "REQACCESS"
corrupted or noisy Running VERIFY action on a | register in eNVM Control Registers
blank device. (address 0x600801FC) to release the
access,
Bitstream file has been Program the device prior to running
corrupted VERIFY action
Bitstream was incorrectly Regenerate bitstream file.
generated
0x8021 -23 Authentication Error File contains an encrypted key | Provide a programming file with an
0x8022 that does not match the encryption key that matches that on the
Invalid/Corrupted device device.
encryption key
Attempting to erase a device | Run DEVICE_INFO action to verify that
with no security using master | the device has no security. If the device
security file does not have security, you cannot erase
it.
File contains user encryption
key, but device has not been | First program security with master
programmed with the user programming file, then program with user
encryption key encryption 1/2 field update programming
files.
Device has user encryption
key 1/2 enforced and you are | You must first ERASE security with the
attempting to reprogram master security file, then you can
security settings reprogram new security settings.
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Error Exit Exit Message Possible Cause Possible Solution
Code Code
0x8041 -23 Authentication Error File contains an encrypted key | Provide a programming file with an
that does not match the encryption key that matches that on the
Invalid/Corrupted device device.
encryption key
File contains user encryption | Run DEVICE_INFO action to verify that
key, but device has not been | the device has no security. If the device
programmed with the user does not have security, you cannot erase
encryption key it.
Attempting to erase a device | First program security with master
with no security using master | programming file, then program with user
security file encryption 1/2 field update programming
files.
Device has user encryption
key 1/2 enforced and you are | You must first ERASE security with the
attempting to reprogram master security file, then you can
security settings reprogram new security settings.
0x8023 -24 Authentication Error Design version is not higher Generate a programming file with a design
0x8024 than the back-level version higher than the back level version.
0x8042 Back level not satisfied programmed device
0x8001 -24 Failure to read DSN Device is in System Controller | TRSTB should be driven High or disable
Suspend Mode "System Controller Suspend Mode".
Check board connections
0x8025 -25 Authentication Error DSN specified in programming | Use the correct programming file with a
0x8026 file does not match the device | DSN that matches the DSN of the target
0x8043 DSN binding mismatch being programmed device being programmed.
-26 Authentication Error Device does not support the Generate a programming file with the
0x8044 capabilities specified in correct capabilities for the target device.
Insufficient device programming file
capabilities
0x8027 -26 Authentication Error Libero device selection does Generate a programming file with the
0x8028 not match the target device correct device selection for the target
Bitstream and device device.
mismatch
0x8029 -27 Authentication Error Incorrect programming file Choose the correct programming file and
0x802A select the correct device in chain.
0x8045 Incorrect DEVICEID Incorrect device in chain

Measure JTAG pins and noise or

Signal integrity issues on reflection. If TRST is left floating, then add
JTAG pins pull-up to pin.

Reduce the length of ground connection.
0x802B -28 Authentication Error Programming file version is Generate programming file with latest
0x802C out of date version of Libero SoC.

Programming file is out
of date, please
regenerate
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Error Exit Exit Message Possible Cause Possible Solution
Code Code
0x8046 -28 >Authentication Error Old programming file Generate programming file with latest
version of Libero SoC.
Unsupported bitstream
protocol version
0x802F -30 JTAG interface is Invalid or no UPK1 is provided | User needs to provide correct UPK1 to
protected by UPK1 unlock device.
0x8030 -31 Authentication Error M2S090 Rev. A or M2S150 User can program a valid application
0x8031 Rev. A: code. This can be done with SoftConsole.
0x8048 Invalid or inaccessible
Device Certificate Either certificate is corrupted FAB_RESET_N should be tied to HIGH.
or the user hasn't provided the
application code in the eNVM
or provided invalid application
code
FAB_RESET_ N is tied to
ground
0x8032 -32 Instruction timed out Unstable voltage level Monitor related power supplies that cause
0x8033 the issue during programming; check for
0x8034 Signal integrity issues on transients outside of Microsemi
0x8035 JTAG pins specifications. See your device datasheet
0x8036 for more information on transient
0x8037 specifications.
0x8038
0x8039 Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.
0x8010 -35 Failed to unlock User Pass key in file does not Provide a programming file with a pass
Pass Key 1 match device. key that matches pass key programmed
into the device.
Plaintext pass key match is
disabled. This occurs if HSM Match pass key using HSM.
was used to program the
device.
0x8011 -35 Failed to unlock User Pass key in file does not Provide a programming file with a pass
Pass Key 2 match device. key that matches pass key programmed
into the device.
Plaintext pass key match is
disabled. This occurs if HSM Match pass key using HSM.
was used to program the
device.
0x8012 -35 Failed to unlock debug Pass key in file does not Provide a programming file with a pass
pass key match device. key that matches pass key programmed
into the device.
Plaintext pass key match is
disabled. This occurs if HSM Match pass key using HSM.
was used to program the
device.
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Security programmed.
Please erase the device
using master file before
reprogramming Security
Settings.

reprogramming device directly
if Security has already been
programmed.

device.

Error Exit Exit Message Possible Cause Possible Solution
Code Code
0x804D -36 <HSM related error HSM communication error. Check if HSM the communication path to
message based on HSM call returns error. HSM is up. Make sure project is loaded
scenario> properly and that HSM tickets have not
been cleaned.
0x804E -37 Device already has HSM flow does not support Erase security and try programming the
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SmartDebug

Microsemi's SmartDebug tool complements design simulation by allowing verification and troubleshooting at the
hardware level.

For detailed information about SmartDebug for SmartFusion2, IGLOO2, and RTG4, refer to the SmartDebug User
Guide (SmartFusion2, IGLOO2, RTG4).

For detailed information about SmartDebug for PolarFire, refer to the SmartDebug User Guide (PolarFire).
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Electrical Parameters

DC Characteristics for FlashPro6

Table 2 - DC Characteristic for FlashPro6

Parameter Test VITAG Min Typ Max Unit
Condition Voltage
Range
Vi High- 1.20V - 1.95V VJTAG_VSPI x 0.65 Vv
level input
voltage 1.95V - 2.70V 16 v
2.70V - 3.60V 2 Vv
Vi Low- 1.20V - 1.95V VITAG_VSPIX0.35 |
i/eovlte;égp”t 1.95V - 2.70V 0.7 v
2.70V - 3.60V 0.8 Vv
Von lon=—100pyA | 1.2V103.6V VJTAG_VSPI - 0.2 Vv
lon= -3MA 1.2V Vv
lon= -6MA 1.4V 1.05 v
lon = -8mA 1.65V 1.2 0.95 Vv
lon= -9mA 2.3V 1.75 Vv
low=-12mA | 3V 2.3 Vv
VoL lon=—-100pyA | 1.2V103.6V Vv
lon = -3mA 1.2V 0.25 Vv
lon= -6MA 1.4V Vv
lon= -8MA 1.65V Vv
lon = -9mA 2.3V Vv
lon=-12mA | 3V Vv
low High- 11Vto1.2V 3 mA
'cf"uvrigt” fout 1.4V101.6V 6 mA
1.65V to 1.95V -8 mA
23V102.7V -9 mA
3Vt 3.6V 12 mA
11Vto1.2V 3 mA
14V101.6V 6 mA
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lo. Low-level 1.65V to 8 mA
output 1.95v
current 9
23Vto2.7V mA
3V1t03.6V 12 mA

DC Characteristics for FlashPro5/4/3/3X

Note: The target board must provide the VCC, VCCI, VPUMP, and VJTAG during programming.

Note: The VJTAG signal is driven from the target/DUT board. The VJTAG pin is sensed by the FP4 to
configure the internal input and output buffers to the same IO Voltage levels. The VITAG pin is only

an input pin to the programmer.
Table 3 - DC Characteristic for FlashPro5/4/3/3X

Description Symbol Min Max Unit
Input low voltage, TDO VIL -0.5 0.35*VITAG \%
Input high voltage, TDO VIH 0.65*VITAG 3.6 \%
Input current, TDO 1L, HH -20 +20 mA
Input capacitance, TDO 40 pF
Output voltage, VPUMP, operating VPP +3.0 +3.6 \%
Output current, VPUMP IPP 250 mA
VITAG = 1.5V
Output low voltage, TCK, TMS, TDI, 100pA load VOL 0.0 0.2 \Y
Output low voltage, TCK, TMS, TDI, 4mA load VOL 0.0 0.30*VJTAG \%
Output high voltage, TCK, TMS, TDI, 100pA load \Y VJTAG-0.2 VITAG \Y
Output high voltage, TCK, TMS, TDI, 4mA load VOH 0.70*VJTAG VITAG \%
Output current, TCK, TMS, TDI 10L, IOH -4 +4 mA
VJITAG = 1.8V
Output low voltage, TCK, TMS, TDI, 100pA load VOL 0.0 0.2 \Y
Output low voltage, TCK, TMS, TDI, 6mA load VOL 0.0 0.3 \%
Output high voltage, TCK, TMS, TDI, 100pA load VOH VJTAG-0.2 VITAG \Y
Output high voltage, TCK, TMS, TDI, 6mA load VOH 1.25 VITAG \%
Output current, TCK, TMS, TDI 10L, IOH -6 +6 mA
VJITAG = 2.5V
Output low voltage, TCK, TMS, TDI, 100pA load VOL 0.0 0.2 \Y
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Description Symbol Min Ma Unit
X

Output low voltage, TCK, TMS, TDI, 8mA load VOL 0.0 0.6 \Y
Output high voltage, TCK, TMS, TDI, 100pA load | VOH VJTAG-0.2 VITAG \Y
Output high voltage, TCK, TMS, TDI, 8mA load VOH 1.8 VITAG \%
Output current, TCK, TMS, TDI IOL, IOH | -8 +8 mA
VJITAG = 3.3V

Output low voltage, TCK, TMS, TDI, 100pA load VOL 0.0 0.2 \Y
Output low voltage, TCK, TMS, TDI, 8mA load VOL 0.0 0.4 \Y
Output high voltage, TCK, TMS, TDI, 100pA load | VOH VJTAG-0.2 VITAG \Y
Output high voltage, TCK, TMS, TDI, 8mA load VOH 2.4 VITAG \%
Output current, TCK, TMS, TDI IOL, IOH | -8 +8 mA
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Electrical Specifications

FlashPro6

The FlashPro6 is a JTAG-based programmer for flash based Microsemi devices.

The FlashPro6 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector on
the FlashPro6 unit is a 2x5, RA male Header connector, which is manufactured by 3M and has a manufacturer’s
part number of N2510-5002-RB. This is a standard 2x5, 0.1 pitch connector which is keyed. Use the 10 pin right-
angle header, 3M P/N N2510-5002-RB (DigiKey P/N MHE10K-ND) for FlashPro6 and use the 10 pin straight
header,

The signals on the pins of the FlashPro6 10-pin connector are shown in the figure below.

<— TCK/SCK |1 2 | GND a4

—» TDO/MISO | 3 4 | NC

4— TMS/SS 5 6 | VITAG/VSPI <4—
NC[7 8 | TRSTB —»

«4— TDI/MOSI |9 10, GND P

Figure 25 - FlashPro6 10-Pin Connector

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer itself.
Arrows show current flow towards or from the rectangular programmer.

The table below shows a description of the signals.

Table 4 - FlashPro6 Signal Description

Signal Description
GND Signal reference
TCK/SCK JTAG clock; SPI clock
TDI/SDI JTAG data input to device; SPI MOSI
TDO/SDO JTAG data output from device; SPI MISO
TMS/SS# JTAG mode select; SPI Chip Select
NTRST Programmable output pin may be set to off, toggle, low, or high level
VITAG Reference voltage from the target board
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Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied to
ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset state by
default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even will not
suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-down
resistor on TRST on your board, then enabling the “Drive TRST” flag will be required to force the JTAG state-
machine out of reset to permit programming to take place. With most boards, there is no need to select this flag.

FlashPro5

The FlashPro5 is a JTAG and a SPI based programmer for flash based Microsemi devices.

The FlashPro5 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector on
the FlashPro5 unitis a 2x5, RA male Header connector, which is manufactured by AMP and has a manufacturer’s
part number of 103310-1. This is a standard 2x5, 0.1 pitch connector which is keyed. Use the 10 pin right-angle
header, AMP P/N 103310-1 (DigiKey P/N A26285-ND) for FlashPro4 and use the 10 pin straight header, AMP
P/N 103308-1 (DigiKey P/N A26267-ND) for the straight version.

The signals on the pins of the FlashPro5 10-pin connector are shown in the fiqure below.

GND +—»

- TCK/SCK | 1 2

- TDO/MISO | 3 4 | PROG_MODE —P
-~ TMS/SS 5 6 | WITAG/VSPI <—
+—— VPUMP [ 7 8 | TRSTB —
4— TDI/MOSI | 9 10| GND P

Figure 26 - FlashPro5 10-Pin Connector

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The table below shows a description of the signals.

Table 5 - FlashPro5 Signal Description

Signal Description
VPUMP 3.3V Programming voltage
GND Signal reference
TCK/SCK JTAG clock; SPI clock
TDI/SDI JTAG data input to device; SPI MOSI
TDO/SDO JTAG data output from device; SPI MISO
TMS/SS# JTAG mode select; SPI Chip Select
NTRST Programmable output pin may be set to off, toggle, low, or high level
VITAG Reference voltage from the target board
PROG_MODE IGLOO v2 family - Used for switching from VCC 1.2V to 1.5V during programming
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Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied to
ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset state by
default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even will not
suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-down
resistor on TRST on your board, then enabling the “Drive TRST” flag will be required to force the JTAG state-
machine out of reset to permit programming to take place. With most boards, there is no need to select this flag.

FlashPro4

The FlashPro4 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector on
the FlashPro4 unitis a 2x5, RA male Header connector, which is manufactured by AMP and has a manufacturer’s
part number of 103310-1. This is a standard 2x5, 0.1 pitch connector which is keyed. Use the 10 pin right-angle
header, AMP P/N 103310-1 (DigiKey P/N A26285-ND) for FlashPro4 and use the 10 pin straight header, AMP
P/N 103308-1 (DigiKey P/N A26267-ND) for the straight version.

The signals on the pins of the FlashPro4 10-pin connector are shown in the figure below (extracted from
FlashPro4 product specification):

-—  TCK|1 2 |GND  ~—
— TDO|3 4 |PROG_MODE ——
-— Tms[s 6 |VITAG =——
a— Vpump |7 g |nTRST ——=
- TDI|9 10 |GND <——8w

Figure 27 - FlashPro4 10-Pin Connector

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The table below shows a description of the signals.

Table 6 - FlashPro4 Signal Description

Signal Description
VPUMP 3.3V Programming voltage
GND Signal reference
TCK JTAG clock
TDI JTAG data input to device
TDO JTAG data output from device
TMS JTAG mode select
NTRST Programmable output pin may be set to off, toggle, low, or high level
VITAG Reference voltage from the target board
PROG_MODE IGLOO v2 family - Used for switching from VCC 1.2V to 1.5V during programming
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Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied to
ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset state by
default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even will not
suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-down
resistor on TRST on your board, then enabling the “Drive TRST” flag will be required to force the JTAG state-
machine out of reset to permit programming to take place. With most boards, there is no need to select this flag.

FlashPro3

The FlashPro3 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector on
the FlashPro3 unit is a 2x5, RA male Header connector, which is manufactured by AMP and has a manufacturer’'s
part number of 103310-1. This is a standard 2x5, 0.1 pitch connector which is keyed. Use the 10 pin right-angle
header, AMP P/N 103310-1 (DigiKey P/N A26285-ND) for FlashPro5/4/3/3X and use the 10 pin straight header,
AMP P/N 103308-1 (DigiKey P/N A26267-ND) for the straight version.

The signals on the pins of the FlashPro3 10-pin connector are shown in the figure below (extracted from
FlashPro3 product specification):

-~ TCK|1 2 |[GND  ~—
—  TDO|3 4 |NfC

*—TMS[S & |VITAG =——
a— Vpump |7 & |nTRST ——=
« TDI|9 10 [GND <«—»

Figure 28 - FlashPro3 10-Pin Connector

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The table below shows a description of the signals.

Table 7 - FlashPro3 Signal Description

Signal Description
VPUMP 3.3V Programming voltage
GND Signal reference
TCK JTAG clock
TDI JTAG data input to device
TDO JTAG data output from device
T™MS JTAG mode select
NTRST Programmable output pin may be set to off, toggle, low, or high level
VITAG Reference voltage from the target board
N/C Programmer does not connect to this pin
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Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied to
ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset state by
default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even will not
suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-down
resistor on TRST on your board, then enabling the “Drive TRST” flag will be required to force the JTAG state-
machine out of reset to permit programming to take place. With most boards, there is no need to select this flag.

JTAG Switching Characteristics
FlashPro6 Characteristics

Table 8 - JTAG Switching Characteristics for FlashPro6

Description Symbol Min Max Unit
Output Delay from TCK to TDI, TMS TTCKTDI 2 2.2 ns
TDO setup time before TCK rising, VITAG=3.3V TTDOTCK 114 481 ns
TDO setup time before TCK rising, VITAG=1.5V TTDOTCK 105 487 ns
TDO Hold time after TCK rising TTCKTDO 0 -
TCK period TTCK 49.4 - ns

FlashPro5/4/3/3X Characteristics

Table 9 - JTAG Switching Characteristics for FlashPro5/4/3/3X

Description Symbol Min Max Unit
Output delay from TCK to TDI, TMS TTCKTDI -2 2 ns
TDO setup time before TCK rising, VJITAG=3.3 TTDOTCK 12 ns
TDO setup time before TCK rising, VITAG=1.5 TTDOTCK 14.5 ns
TDO hold time after TCK rising TTCKTDO 0 ns
TCK period TTCK 41.7 10667 ns
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lllustration of the JTAG Switching Characteristics

The figure below is an illustration of the JTAG switching characteristics.

.
X
- W+W

TCK

TMS, TDI

L.
-—[7cx e

Trowton —

Troo T:HAD‘

TrckToo—

Figure 29 - JTAG Switching Characteristics
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FlashPro Express Reference

FlashPro Express Start Page

The FlashPro Express Start Page is the first page to show when the tool starts up. This page provides the
interface for loading a project into the tool by either navigating to the project location, or clicking on one of the
recently opened projects.

FlashPro Express Project Menu

Command

Function

New Job Project from
Programming Job

New job project folder with programming job name will be created at
the specified location.

Open Job Project

Loads a job project into the tool by reading the information in user
specified .pro file.

Close Job Project

Closes the current job project

Save Job Project

Saves the current job project

Set Log File

Sets the location of the Log file to your specified location.

Export Log File

Exports the Log file to your specified location.

Preferences

Allows you to select Flash Pro Express mode.

Execute Script

Runs your specified Tcl script.

Export Script File

Exports all commands run in this session to your specified path as a
Tcl script

Exit

Exits FlashPro Express

FlashPro Express Edit Menu

Command Function

Clear Log Window Clears the Log window

FlashPro Express View Menu

The View menu shows or hides the FlashPro Express GUI elements.

Command Function

Log Window Shows/hides the Log window
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FlashPro Express Programmer Menu

Command Function

Programmer Settings Opens the Programmer Settings dialog box; enables you to set options
for all types of supported Microsemi programmers

Disable Core Check During | Disables core checking during scan and check chain operations.
Scan and Check Chain

FlashPro Express Help Menu

Command Function
Help Topics Opens the help
Microsemi Technical Opens the Microsemi technical support site.
Support
Microsemi Web Site Opens the Microsemi website in your default browser
User Guide Opens the FlashPro Express User Guide.
Check for Software Updates | Checks for software updates (works only if you are connected to the
internet)
About FlashPro Express Lists the FlashPro Express release information

FlashPro Express Log Window and Status Bar

FlashPro Express Log Window

The FlashPro Express log window shows status messages for user activity. Click on the appropriate tab (Messages,
Errors, Warning, Info) to filter messages by type.

e Use the right-click menu to copy text, clear the log, and scroll thelog.
e Use the def variable LOG_WINDOW_BUFFER_SIZE to set the buffer size.
e Use the View menu to show or hide the Logwindow.

FlashPro Express Status Bar
The Status Bar at the bottom displays the status of the load project action.
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Appendix A: Sample Programming and
SmartDebug Times Using
FlashPro5/FlashPro6

The tables in this appendix show sample programming times using FlashPro5 and FlashPro6
programmers.

The following table shows sample PPD programming times.

PPD Programming Time?
(mm:ss)
Devicest FlashPro5 FlashPro6
TCK=4MHz TCK=4MHz TCK=20MHz3
USB 2.0 USB 2.0/3.0 USB 2.0/3.0
M2S/A2GL 005
M2S/A2GL 010
M2S/A2GL 025
M2S/A2GL 050 2min 9sec 2min 10sec 2min 2sec
M2S/A2GL 060
M2S/A2GL 090
M2S/A2GL 150 4min 21sec 4min 19sec 3min 54sec
RTG4 2min 10sec 1min 56sec 1min 33sec
MPF100 39sec 28sec 23sec
MPF200 1min 3sec 43sec 28sec
MPF300 1min 33sec 1min 4sec 43sec
MPF500 1min 57sec 1min 34sec 1min

Notes:
1FlashPro6 supports JTAG programming for all SmartFusion2, IGLOO2, RTG4 and PolarFire devices.

2To benefit from the improved programming time using FlashPro6, use the PPD file format for
SmartFusion2, IGLOO2 and PolarFire devices. Programming time speed up with PPD will be added in
future releases.

3To ensure successful programming at 20MHz TCK, appropriate steps need to be taken to ensure signal
integrity of the JTAG signals.
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Splash Kit
(N25Q00AA13GSF40G / PPD Programming
MT25QL01GBBB8ESF- Time
0SIT TR)? FlashPro FlashPro
10MByte 62
data
TCK = 4MHZ TCK = 15MHz3 TCK =4MHZ | TCK = TCK =
15MHz3 20MHz3
USB 2.0 USB 2.0 USB 2.0/3.0 | USB 2.0/3.0 USB 2.0/3.0
Program SPI Flash 8min 30sec 5min 29sec 22min 12sec | 13min 9sec 12min 11sec
Verify SPI Flash 2hrs 22min 10sec | 2hrs 10min 28sec | 23min 05sec | 14min 17sec | 13min 21sec
Read SPI Flash 2hrs 34min 20sec 2hrs 23min 45sec | 22min 30sec | 13min 54sec | 12min 55sec
Erase SPI Flash 19sec 18sec 1min 51sec 1min 49sec 1min 48sec

Notes:

1SPI Flash programming has been tested on N25Q00AA and MT25QL01G/MT25QU01G
devices only. Contact technical support for other SPI-Flash device support needs.

2FlashPro6 has longer programming times for SPI Flash devices, when compared to

FlashPro5. However, readback and verification times are significantly shorter. Programming
time for FlashPro6 will be improved in future releases.

3To successfully program the device at a high TCK frequency, appropriate steps must

be taken to ensure signal integrity of the JTAG signals.

* FlashPro5 supports MT25QL01G and N25Q00AA13Gxx40G only.
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Contacting Microsemi

Microsemi SoC Products Group Headquarters

Microsemi Corporation is a supplier of innovative programmable logic solutions, including field-programmable
gate arrays (FPGASs) based on antifuse and flash technologies, high-performance intellectual property (IP) cores,
software development tools, and design services targeted for the high-speed communications, application-specific
integrated circuit (ASIC) replacement, and radiation-tolerant markets.

Address: Microsemi SoC Products Group
3870 North First Street
San Jose, CA 95134

Phone: 408-643-6000

Contact Information
For the most up-to-date contact information, check the Microsemi Home Page.
Contact information for FPGAs & SoCs can be found at the FPGAs and SoCs Support Page
If you do not have internet access, the following information was accurate at the time of publication:

e Technical Support
e Web: https://soc.microsemi.com/mycases
e Phone (NA): 800.262.1060
e Phone (Int'l): +1 650.313.4460
e Email: soc_tech@microsemi.com

e Customer (non-technical) Support

e Phone: +1650.318.2470

e Email: customer.service@microsemi.com
e Sales Support

e For pricing, order status and lead time information for all Microsemi SoC products, contact your.
Microsemi Sales Representative

e Technical Support for RH and RT FPGAs that are regulated by International Traffic in Arms Regulations
(ITAR)

e Phone (NA): 888.988.ITAR
e Phone (Int'l): +1 650.318.4900
e Email: soc_tech_itar@microsemi.com

Regulatory and Compliance Information

EU Declaration of Conformity:

This product complies with Directive 2011/65/EU of the European Parliament and of the Council of 8 June 2011
on the restriction of the use of certain hazardous substances in electrical and electronic equipment.

To view the Declaration of Conformity in English:
http://www.microsemi.com/index.php?option=com_docman&task=doc_download&gid=131772
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FlashPro Express User Guide

Non-English:
http://www.microsemi.com/index.php?option=com_docman&task=doc download&gid=131748

Markings:

c € This product complies with 2004/108/EC, Electromagnetic Compatibility (EMC) Directive

For Korea:
Type of Equipment User's Guide
0] 717l ESEAs) TALEHEZZ|IZM T
Ag 77|

OjX} £ AFRAHS O] HE ZojstAl7| Hiet
(858 BSSUWIRM | o spmolo) x| ARSI 2He 2Xoz
st

Class A Equipment This  equipment  is  Industrial  (Class  A)
(Industrial Broadcasting & clectromagnetic wave suitability equipment and
Communication Equipment) | seller or user should take notice of it, and this
equipment is to be used in the places except for home.
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